
Cheat sheet for the report template in the series 
Linnaeus University Dissertations 

Introduction 
The reason for using the LUD template when writing your report is partly that it 
will save you a lot of time, if used in the right way, and partly that it ensures the 
printed material will be uniform and correct. The template is adapted to meet the 
Swedish requirements of accessibility to digital public services. Using the template 
in a consistent way will thus ensure that the full text files (pdf) created from the 
template document will be accessible according to Swedish requirements.  

In monographs, the whole text should be placed in the template, in compilation 
reports only the extended summary (kappan). Included articles are handed in as 
separate pdf files. 

The work with entering your material can be done in two different ways. Either 
you type all your material directly into the template – you will then benefit from 
the auto-formatting offered by the template and will not be required to do as much 
formatting on your own – or you can choose to copy/paste your texts into the 
template and then format according to the styles offered in the template. Choose 
the alternative that suits you best. 

The most important thing to keep in mind when working with templates is to stick 
to the styles in the template and not do any formatting of your own. In other words, 
avoid manual adjustments like using the space bar in order to create indentation or 
make extra line spacing before and/or after headings. This type of formatting is 
already specified in the styles of the template. 

Document templates 

Styles 

The document template controls the physical format of the publication and what 
the layout should look like for different sections of the publication. The reports 
template is formatted to 165 x 242 mm. Basically, the template is an empty Word 
document in the right size, containing a number of styles. The styles are described 
with example texts in a Sample setting that you get alongside the template. The 
template does not regulate formalities like what reference system to use or in what 
order different sections should appear. 

The dissertation format is not a standard format; therefore, printers sometimes have 
trouble figuring out what paper size to use. In case the printer protests and asks 
what format is to be used, choose A4. 

The styles control both how individual characters and how entire sections of text 
are formatted. There are two different style types; character styles, describing 
characteristics like bold in selected words regardless of underlying section style; 
and paragraph styles, controlling the font as well as the formatting of the section; 
for instance, indentation, space before/after, and placement of the text. Always use 
the style Emphasis (for Italics) and Strong (for Bold) and these will follow even if 
you change the paragraph style. This is handy when you format the Bibliography or 
Footnote texts. 

The report template contains styles for most types of text that can be expected to 
occur, and you should primarily use these templates in order to create 



uniformity in the report series. If you are in need of more styles you should 
create new ones instead of trying to change texts manually. All styles are 
exemplified in the Sample setting. 

Start using the template 

Writing directly in the template 
When you type your text directly in the template you should start by choosing a 
style for the text you are about to write from the Styles Gallery on the Home tab, or 
in the Styles Pane. The Styles Pane is opened by clicking the small arrow under the 
Styles Gallery (Windows) or the Styles Pane button (Mac). Place the marker in the 
section you are working with and then choose the preferred style. The section will 
then be formatted accordingly.  

Word for Windows Word for Mac 

The styles are constructed so that they will make it easier for the writer, in that 
when pressing Enter, the next section will be formatted to the most likely format. 
For instance, when writing Heading 1 and then pressing Enter, the following 
section will automatically be formatted as Body Text. 

Note that the automatic formatting described above only is active when you write 
your text directly in the template. In order to format a text that has already been 
typed in or to change the format of a section, you must place the marker in the 
section and choose the preferred style from the Styles Pane.  

To copy/paste written material 
In many cases, there is previously written material to be pasted in to the template. 
One problem that may occur when copying a text between two documents is that 
the formatting from the source document is transferred to the target document, 
which means that on the one hand, your text will not be correctly formatted until 
you choose the correct style, and on the other hand, the styles from the source 
document will remain in the Styles Pane. 



There is, however, ways to avoid transferring styles from another document when 
copying text. When you paste, choose Merge formatting (Windows) or Match 
formatting (Mac). 

Word for Windows Word for Mac 

If this doesn’t work satisfactorily, choose Keep text only when pasting. Please 
observe that italics and other emphases will disappear using this alternative. You 
will then need to format the text using the styles in the template. 

Word for Windows Word for Mac 

To format text pasted as Keep text only, you need to work with one section or 
heading at the time. Place the marker in the section/heading in question and choose 
the desired style, then move on the next section and choose style again. Compare 
with the Sample setting if you are uncertain. 

During the course of work 

Insert pictures 
All pictures should be inserted where you want them. If the material is to be printed 
in black and white, it is preferrable to convert all pictures to greyscale using a 
photo editor. Furthermore, it is important that the pictures have a resolution of 300 
dpi, in order to be printed in high quality. 

Use the style Caption for captions and descriptions. 





Table of contents 
The table of contents is placed on the first page of the template. It has to be updated 
manually to ensure that all headings will be included after you are done formatting 
the text. You update by placing the marker somewhere in the table of contents and 
choose Update Table, Update entire table. 

The table of contents will include all the text formatted as Heading 1–3. Make sure 
to format all the headings in the text, using the heading styles offered by the 
template. To make the first chapter of the dissertation start on a right-hand side, a 
blank page will be added automatically after the table of contents if needed. 

Your own styles 
If you need a style that is not included in the template, you can create your own. 
Do this by creating a new style, do not change an existing style. Creating and using 
new styles is quicker than formatting text manually because all sections based on 
the new style will be updated automatically, should you later on wish to change the 
added style. 

Tables 
Keep in mind that the book format has a column width of 11,5 centimeters. 
Therefore, adjust your tables to that format from the start in order to avoid 
problems that may occur if you paste tables made in A4 to the template. 

Captions to figures and tables 
Type the description you wish to accompany your figure or table using the style 
Caption. 

If you want to be able to make an automatic list of all figures or tables, choose 
Insert Caption under the References tab and then Figure or Table. The 
description will automatically get the right style. Then place the marker where you 
want the list to appear and choose Insert Table of Figures. 

Page numbering 
Page numbering is activated as default in the template, which means that generally 
you should not be required to change that. Keep in mind the book format and make 
sure that the introductory pages, such as dedication and the table of contents, 
always start at right-hand sides. Add Page Breaks where needed. Right-hand pages 
always have an odd page number placed in the lower right-hand corner. Left-hand 
pages are even and the page number is placed in the lower left-hand corner. After 
the first chapter, you do not have to consider right- and left-hand pages. 



Send to print 
The material should be sent to Fojo as a pdf file. 

Create PDF in Word for Windows 
Choose Save as Adobe PDF on the File menu. Select a name, where the file is to 
be saved and click Save. The pdf file will be generated and opened in Adobe 
Acrobat. 

Create PDF in Word for Mac 

Questions? 

Click File, Print (cmd + P). In the next window, choose Save as Adobe PDF (if 
you get a question whether you want to continue despite footers outside the 
printable area, choose Yes). In the next window choose Press Quality and save the 
file. 

If you have any questions regarding the template or the production process, please 
contact info.fojo@lnu.se. 



Choosing the right style 
Below please find a brief description of the styles used in the template and when to 
use them. For style examples, please see the Sample setting. 

 Style  Use  Details 
 Captions  Use for captions and descriptions to figures and 

tables. 
 Format for following section: Body Text. 

Font: Times New Roman, 9 pt, Italics, Single Line 
Spacing 

 Body Text  Use for body text following a heading or for 
sections below a figure or table. 

 Format for following section: Body Text First 
Indent. Font: Times New Roman, 10,5 pt, Line 
Spacing At Least 12 pt. 

 Body Text First Indent  Use for body text which does not appear following a 
heading or below a figure or table. Has an first line 
indent of 0,4 cm to mark a new section. 

 As Body Text but with First Line Indent of 0,4 cm, 

 Body Text 2  Use for text sections which you want to deviate 
from the body text. This style has a left indentation 
of 1 cm. 

 Font: Times New Roman, 10,5 pt, Indentation, Left 
1 cm, Line Spacing At Least 12 pt. 

 Quote  Use for quotes. Italics and indentation left and right 
of 1 cm. 

 Format for following section: Body Text. Times 
New Roman, 10,5 pt, Italics, Line Spacing At Least 
12 pt. 

 Footnote Reference  Use for the numbering of footnotes. Is formatted 
automatically when you add the footnote. Use this 
style only for corrections, for example in pasted 
text. 

 Font: Times New Roman, Elevated 

 Footnote Text  Use for footnote text. Is formatted automatically 
when you start typing the footnote text. Use this 
style only for corrections, for example in pasted 
text. 

 Font: Times New Roman, 8 pt, Indentation 0,2 cm, 
Single Line Spacing 

 TOC 1  Use for Heading 1 in the Table of Content. Is 
formatted automatically when you create/update the 
Table of Content. Use style only for corrections. 

 Body Text + Tabs: 11,5 cm Adjusted right with 
dotted line to page number. Automatically updated. 

 TOC Heading  Use only for heading for the Table of Content (will 
not appear as heading in the TOC) 

 Font: Times New Roman, 19 pt, Bold, , Line 
Spacing At Least 22 pt. 

 TOC 2  Use for Heading 2 in the Table of Content. Is 
formatted automatically when you create/update the 
Table of Content. Use style only for corrections. 

 TOC 1 + Indentation Left 0,37 cm, Automatically 
updated. 

 TOC 3   Use for Heading 3 in the Table of Content. Is 
formatted automatically when you create/update the 
Table of Content. Use style only for corrections.. 

 TOC 2 + Indrag: Indentation Left 0,74 cm, 
Automatically updated. 

 Empasis  Use to use single words or sentences in italics. Use 
this style instead of marking words and clicking the 
italic symbol. 

 Italics 

 Bibliography  Use for bibliography  Font: Times New Roman, 9 pt, Hanging 0,4 cm, 
Line Spacing At Least 11 pt. 

List Bullet  For bulleted lists. Remember to press Enter for any 
new item. 

 Body Text, hanging + List Bullet, Tabs: 0,5 cm,  

 Heading 1  Use for chapter headings  Format for following section: Body Text,.Font: 
Times New Roman, 19 pt, Bold, Line Spacing At 
Least 22 pt, Before 105 pt, After 22 pt 

 Rubrik 2  Use for subheading 1  Format for following section: Body Text, Font: 
Times New Roman, 15 pt, Bold, Line Spacing At 
Least 16 pt, Before 18 pt, After 6 pt. 

 Rubrik 3  Use for subheading 2  Format for following section: Body Text, Font: 
Times New Roman, 12 pt, Bold, Line Spacing At 
Least 13 pt, Before 9 pt, After 3 pt. 



 Rubrik 4  Use for subheading 3.  Format for following section: Body Text 
Times New Roman 10,5 pt, Bold, Line Spacing At 
Least 12 pt, Before 9 pt. After 3 pt.  

 Fotter  Use for formatting of the page number in the footer. 
Is formatted automatically. Use this style only for 
corrections only.  

 Font: Times New Roman, 10,5 pt, Different Odd 
and Even Pages. 

 Strong  Use to use single words or sentences in bold type. 
Use this style instead of marking words and clicking 
the bold symbol. 

 Underliggande + Teckensnitt: Fet 

 Normal  Words´s standard style, must be included but should 
not be used. 

 Font: Times New Roman, 10,5 pt, Line Spacing 
Exactly 12 pt. 
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